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1 Switch between activities

1.1 Switch to another page by starting another activity
Every single page in an app is an activity. If we want to navigate to another page, we
have to start another activity. In this example, we will learn how to start an activity,
how to send the data to another activity and how to get back the result from an
activity.

1. Create a new project called SwitchActivity with Create activity option checked in
Configure Project step. Click next in the rest of steps and refer to the screenshot

below for the information at the first step.

) New Android Application G X |
New Android Application
15 The prefix 'com.example.’ is meant as a placeholder and should not be used L

Application Name:® SwitchActivity]
Project Mame:® Switch&ctivity

Package Mameid com.exampleswitchactivity

Minimum Required SDK:8| APL8: Android 2.2 (Froyo) - |
Target SDK:8| APL16: Android 4.1 (Jelly Bean) - |

Compile With:5| API17: Android 4.2 (Jelly Bean) - |
Theme:8| Holo Light with Dark Action Bar -

w Theapplication name is shown in the Play Store, as well as in the Manage Application list in Settings.

@ <Back || Nea> || Finish

2. Replace the content of activity_main.xml with the following markup:
<LinearLayout xmIns:android="http://schemas.android.com/apk/res/android"
xmins:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"

android:layout_height="match_parent"
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android:orientation="vertical">

<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="Input from Activity 2:"
android:textSize="20sp" />

<TextView
android:id="@+id/resultFromAct2"
android:layout_width="match_parent"
android:layout_height="wrap_content"

android:layout_marginTop="5dp"/>

<LinearLayout
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:orientation="horizontal"

android:layout_marginTop="30dp">

<EditText
android:id="@+id/inputAct1"
android:layout_width="match_parent"
android:layout_height="wrap_content"

android:layout_weight="1"/>

<Button
android:id="@+id/go"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_weight="0"
android:text="Go"/>
</LinearLayout>

</LinearlLayout>

3. Right click src/com.example.switchactivity, select New > Other > Android >
Android Activity to create the second activity in the same project.
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(@ New BTN

Select a wizard
Create an Android Activity

Wizards:
type filter text

[ = General
4 [= Android
@ .;F_\nfl:!ro_id Acti_l.rity.’
{2 Android Application Project
6 Android Icon Set
Android Object
{2 Android Project from Existing Code
{2 Android Sample Project
Ji Android Test Project
|4 Android XML File
| Android XML Layout File
|4/ Android XML Values File

»

m

@ TN e

4. Select BlankActivity, type MainActivity2 in Activity Name and uncheck Launcher
Activity. Click Finish to create the second activity.

.
@) New Activity — | =

New Blank Activity

Creates a new blank activity, with cptional inner navigation.

Project: | SwitchActivity -

Activity Mame® MainActivity2

Layout Name® activity_main_2

Title® MainActivity2

8[| Launcher Activity
Hierarchical Parent® Optional B
Mavigation Typeﬁ[None vl

o The name of the activity. For launcher activities, the application title.

@ <Back || Net> |[ Fnish || cancel
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5. Replace the content of activity_main_2.xml with the following markups:
<LinearLayout xmlIns:android="http://schemas.android.com/apk/res/android"
xmlns:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"

android:orientation="vertical">

<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="Input from Activity 1:"
android:textSize="20sp" />

<TextView
android:id="@+id/resultFromAct1"
android:layout_width="match_parent"
android:layout_height="wrap_content"

android:layout_marginTop="5dp"/>

<LinearLayout
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:orientation="horizontal"

android:layout_marginTop="30dp">

<EditText
android:id="@+id/inputAct2"
android:layout_width="match_parent"
android:layout_height="wrap_content"

android:layout_weight="1"/>

<Button
android:id="@+id/back"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_weight="0"
android:text="Back"/>

5
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</LinearLayout>

</LinearLayout>

6. Replace the contents of MainActivity.java with the following codes:

package com.example.switchactivity;
import android.os.Bundle;

import android.app.Activity;

import android.content.Intent;

import android.util.Log;

import android.view.View;

import android.view.View.OnClickListener;
import android.widget.Button;

import android.widget.EditText;

import android.widget.TextView;

public class MainActivity extends Activity {

TextView resultFromAct2;
EditText inputActl;
Button go;

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedlnstanceState);
setContentView(R.layout.activity_main);
resultFromAct2 = (TextView)findViewByld(R.id.resultFromAct2);
inputActl = (EditText)findViewByld(R.id.inputAct1);
go = (Button)findViewByld(R.id.go);
go.setOnClickListener(goBtnListener);

private OnClickListener goBtnListener = new OnClickListener(){

@Override

public void onClick(View arg0) {
Bundle bundle = new Bundle();
bundle.putString("myText", inputActl.getText().toString());

6
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startActivityForResult(new Intent(MainActivity.this,
MainActivity2.class).putExtras(bundle), 0);

}

@Override
protected void onActivityResult(int requestCode, int resultCode, Intent data) {
super.onActivityResult(requestCode, resultCode, data);
if(requestCode == 0 && resultCode == RESULT_OK){
Bundle bundle = data.getExtras();
if(bundle!=null){
Log.v("resultFromAct2", bundle.getString("resultFromAct2"));
resultFromAct2.setText(bundle.getString("resultFromAct2"));

7. Replace the contents of MainActivity2.java with the following codes:

package com.example.switchactivity;
import android.os.Bundle;

import android.app.Activity;

import android.content.Intent;

import android.view.Menu;

import android.view.View;

import android.view.View.OnClickListener;
import android.widget.Button;

import android.widget.EditText;

import android.widget.TextView;
public class MainActivity2 extends Activity {
TextView resultFromAct1;

EditText inputAct2;
Button back;
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@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedlinstanceState);
setContentView(R.layout.activity_main_2);
resultFromAct1 = (TextView)findViewByld(R.id.resultFromAct1);
inputAct2 = (EditText)findViewByld(R.id.inputAct2);
back = (Button)findViewByld(R.id.back);
back.setOnClickListener(backBtnListener);

Bundle b = getintent().getExtras();
resultFromAct1.setText(b.getString("myText"));

private OnClickListener backBtnListener = new OnClickListener(){

@Override

public void onClick(View arg0) {
Bundle bundle = new Bundle();
bundle.putString("resultFromAct2", inputAct2.getText().toString());
Intent intent = new Intent();
intent.putExtras(bundle);
setResult(RESULT_OK, intent);
finish();
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8. Run the app in the emulator, type something in the first activity and you will get
back what you typed in second activity after you tapped on the Go button and

vice versa.

s MainActivity2

s SwitchActivity

Input from Activity 2: Input from Activity 1:
Android
. Android . Go . is good! ‘ Back

qwe'r tyui.oop 1T '2'3 4567890
asd f gh j kI @ # S % & * |-+ ()

44 zZ x ¢ vbnm &«

s SwitchActivity

Input from Activity 2:

is good!

. Android - Go

A ] !
The complete project (sample codes) is available at SwitchActivity.zip

9
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2 Understand fragment

Fragment has been introduced since Android 3.0 (API Level 11) or using the Android
Support Library to provide limited support with ActionBar. Fragment is a portion of
an activity which just likes a sub-activity. It is useful when you plan to support both
Phone Ul and Tablet Ul, or create reusable Ul components. Modern Android apps
make use of fragments and ActionBar to create uniformed user navigation and

experience. Good examples include GMail, Maps from Google prior to Android 2.

2.1 Define XML layout for main activity and fragments
1. Start a new Android Application Project in Eclipse and refer to the screenshot
below for application details. Again we will also create a new BlankActivity with

default activity name and layout.

(@) New Android Application [
Mew Android Application ;
It The prefix 'com.example.’ is meant as a placeholder and should net be used 1 J

Application Mame:® FragmentExample
Project Name:@ FragmentExarmple

Package Mame:& com.examplefragmentexample

Minimum Required SDK: 6| API8: Android 2.2 (Froyo) - |
Target SDK:@[APIIE:Android 4.1 {Jelly Bean) vl
CDmpiIeWith:@[APIl?: Android 4.2 (Jelly Bean) v]
Theme:®[HoIo Dark v]

w The application name is shown in the Play Store, as well as in the Manage Application list in Settings.

2. Replace the contents with the following markups in activity_main.xml. We will
add three buttons at the top and a Framelayout to the MainActivity.

<LinearLayout xmins:android="http://schemas.android.com/apk/res/android"

xmins:tools="http://schemas.android.com/tools"

10



2012-13 Workshop on Android app development SIG on Innovative Software, COMP, HKBU
Session 2

android:layout_width="match_parent"
android:layout_height="match_parent"

android:orientation="vertical" >

<LinearLayout
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:gravity="center_horizontal"
android:orientation="horizontal" >
<Button
android:id="@+id/fragButton1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="Frag. 1" />

<Button
android:id="@+id/fragButton2"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="Frag. 2" />

<Button
android:id="@+id/fragButton3"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="Frag. 3" />

</LinearLayout>

<Framelayout
android:layout_width="match_parent"
android:layout_height="match_parent"
android:id="@+id/fragment_container" >

</Framelayout>

</LinearLayout>

3. We also need to create the layout of each fragment, namely fragment_one.xml,

fragment_two.xml and fragment_three.xml. To create an xml layout, simply right

11
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click on the layout folder (in Package Explorer of Eclipse) and select New >

Android XML File.

i£3) New Android XML File

B [ |

New Android XML File

Creates a new Android XML file,

Resource Type: [ Layout

Project: [FragmentExampIe

File: fragment_onexml

Root Element:

- - NurnberPicker

B8 ProgressBar
FQuickContﬁctBadge
(®) RadioButton
[:]F{adinGroup

7 RatingBar

[ RelativeLayout

[ ] scrollview

&, SearchView

i] SeekBar

=

k -]-].]. A

Net> || Finish || Concel |

4. Use the follow markups for the three XML documents respectively:

fagment_one.xml:

<?xml version="1.0" encoding="utf-8"?>

<RelativeLayout xmlins:android="http://schemas.android.com/apk/res/android"

android:layout_width="match_parent"

android:layout_height="match_parent" >

<TextView

android:id="@+id/textView1"
android:layout_width="wrap_content"

android:layout_height="wrap_content"

android:layout_alignParentTop="true"

android:layout_centerHorizontal="true'

android:text="This is fragment 1"

android:textSize="20sp" />

<RatingBar

12



2012-13 Workshop on Android app development SIG on Innovative Software, COMP, HKBU
Session 2

android:id="@+id/ratingBar1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_below="@+id/textView1"
android:layout_centerHorizontal="true"
android:layout_marginTop="19dp" />
<CheckBox
android:id="@+id/checkBox1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignLeft="@+id/ratingBar1"
android:layout_below="@+id/ratingBar1"
android:text="CheckBox" />
</RelativeLayout>

fagment_two.xml:
<?xml version="1.0" encoding="utf-8"?>
<RelativelLayout xmlins:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="match_parent" >
<TextView
android:id="@+id/textView1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignParentTop="true"
android:layout_centerHorizontal="true"
android:text="This is fragment 2"
android:textSize="20sp" />

<RatingBar
android:id="@+id/ratingBar1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_below="@+id/textView1"
android:layout_centerHorizontal="true"

android:layout_marginTop="19dp" />

<RadioButton

13
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android:id="@+id/radioButton1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignLeft="@+id/ratingBar1"
android:layout_below="@+id/ratingBar1"
android:text="RadioButton" />
<RadioButton
android:id="@+id/radioButton2"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignLeft="@+id/radioButton1"
android:layout_below="@+id/radioButton1"
android:text="RadioButton" />

</RelativeLayout>

fagment_three.xml:
<?xml version="1.0" encoding="utf-8"?>
<RelativelLayout xmlins:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="match_parent" >
<TextView
android:id="@+id/textView1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignParentTop="true"
android:layout_centerHorizontal="true"
android:text="This is fragment 3"
android:textSize="20sp" />
<RatingBar
android:id="@+id/ratingBar1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_below="@+id/textView1"
android:layout_centerHorizontal="true"
android:layout_marginTop="19dp" />
<SeekBar
android:id="@+id/seekBar1"

android:layout_width="match_parent"

14
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android:layout_height="wrap_content"
android:layout_below="@+id/ratingBar1"
android:layout_centerHorizontal="true" />
<SeekBar
android:id="@+id/seekBar2"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_below="@+id/seekBarl" />
<SeekBar
android:id="@+id/SeekBar01"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_below="@+id/seekBar2" />
</RelativeLayout>

2.2 Write codes for main activity and fragments
Note: Import android.support.v4d.app when prompt in order to provide backward
compatibility from Android 1.6 to Android 2.x

F

£ Fragment cannot be resolved to a type

10 quick fixes available:

4 import 'Fragment' (android.support.ed. appk it

4_ Import 'Fragment' (android.app)
(® Create class 'Fragment’

@ Change to 'FragmentActiviby' (android.supportad .appl

m

& Change to 'FragmentManager’ (android.app)

@ Change to 'FraamentManaaer’ (android.supportawd.app)

1. If the libs folder does not exist in the project root, simply create it and copy the
android-support-v4.jar from

<your_sdk_folder>/sdk/extras/android/support/v4/ android-support-v4.jar.

@uv| . % Program Files (x86) » adt-bundle-windows-x86 » sdk » extras » android » support » vd » v|&,|r

Organize « |%| Open ~ Burn Mew folder

* Favorites it Mame Date modified Type Size

Bl Desktop | sIC 6/12/2012 9:59 File folder

4 Downloads 4] android-support-vd.jar 9/11/2012 8:54 Executable Jar File 377 KB
v+ Dropbox

5 Google Drive

| Recent Places

2. Right click the android-support-v4.jar in Package Explorer and then select Build
Path > Add to Build Path.

15
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3. We will create three fragment java classes and associate them with the XML
layout files respectively. To create a blank java class file, right click
src/com.example.fragmentexample and select New > Class. Enter FragmentOne
for the name of the first fragment class.

(£3) New Java Class I. =] ﬁ]

Java Class y b

Create a new Java class. l\'\, '—iJJ
Source folder FragmentExample/src

Package: com.examplefragmentexample Browse...
[T Enclosing type: Browse
Mame: FragmentCne
Madifiers: @ public 1 default private protected
[] abstract [|final static
Superclass: java.lang.Object

Interfaces: ‘ Add...

4. Similar to the way of creating an activity, we need to extend the Fragment class if
we want to create a fragment. To define the layout of a fragment, use
Layoutinflater to load the XML layout in onCreateView().

Replace the content of the first fragment class with the following codes:

package com.example.fragmentexample;
import android.os.Bundle;

import android.support.v4.app.Fragment;
import android.view.LayoutInflater;
import android.view.View;

import android.view.ViewGroup;

public class FragmentOne extends Fragment{
@Override
public View onCreateView(LayoutInflater inflater, ViewGroup container,
Bundle savedInstanceState) {
// Inflate the layout for this fragment

16



2012-13 Workshop on Android app development SIG on Innovative Software, COMP, HKBU
Session 2

return inflater.inflate(R.layout.fragment_one, container, false);

5. To create the second and the third fragment classes, select FragmentOne.java in
the Package Explorer, copy and paste it as FragmentTwo.java and
FragmentThree.java respectively.

Note: Replace the resource (R.layout.fragment_one) with FragmentTwo and
R.layout.fragment_two respectivelty for FragmentTwo.java. Perform the same
steps with FragmentThree and R.layout.fragment_three for FragmentThree.java.

6. To perform a transaction such as switch between different fragments in the main
activity, we will use the FragmentManager to create a FragmentTransaction. The
FragmentTransaction allows us to add, remove, replace or even add the
fragment to the back history stack. The FramelLayout defined in

activity_main.xml is used to act as fragment container to hold the fragments.

Replace the content of MainActivity.java with the following code:

package com.example.fragmentexample;

import android.os.Bundle;

import android.support.v4.app.FragmentActivity;
import android.support.v4.app.FragmentTransaction;
import android.view.Menu;

import android.view.View;

import android.view.View.OnClickListener;

import android.widget.Button;

public class MainActivity extends FragmentActivity {

FragmentOne fragmentOne;
FragmentTwo fragmentTwo;
FragmentThree fragmentThree;
Button fragmentOneBtn;
Button fragmentTwoBtn;

Button fragmentThreeBtn;

17
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FragmentTransaction transaction;

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedlinstanceState);
setContentView(R.layout.activity_main);
fragmentOneBtn = (Button)findViewByld(R.id.fragButton1);
fragmentTwoBtn = (Button)findViewByld(R.id.fragButton2);
fragmentThreeBtn = (Button)findViewByld(R.id.fragButton3);

fragmentOneBtn.setOnClickListener(fragmentOneBtnListener);
fragmentTwoBtn.setOnClickListener(fragmentTwoBtnListener);
fragmentThreeBtn.setOnClickListener(fragmentThreeBtnListener);

fragmentOne = new FragmentOne();
fragmentTwo = new FragmentTwo();

fragmentThree = new FragmentThree();

getSupportFragmentManager().beginTransaction().add(R.id.fragment_container,

fragmentOne).commit();

}

private OnClickListener fragmentOneBtnListener = new OnClickListener(){
@Override
public void onClick(View arg0) {
transaction = getSupportFragmentManager().beginTransaction();
transaction.replace(R.id.fragment_container, fragmentOne);

transaction.commit();

}
2
private OnClickListener fragmentTwoBtnListener = new OnClickListener(){
@Override
public void onClick(View arg0) {
transaction = getSupportFragmentManager().beginTransaction();
transaction.replace(R.id.fragment_container, fragmentTwo);
transaction.commit();
}
2

18
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private OnClickListener fragmentThreeBtnListener = new OnClickListener(){
@Override
public void onClick(View arg0) {
transaction = getSupportFragmentManager().beginTransaction();
transaction.replace(R.id.fragment_container, fragmentThree);
transaction.commit();
}
I
}

7. Now try to run the app and you will able to switch the fragments when you click
on the buttons. It also works on Android 1.6 to Android 2.x devices since we are

utilizing the android-support-v4 library in this example.

) FragmentExample FragmentExample

Frag.1 | Frag.2 | | Frag.3

Frag.1 Frag.2 Frag.3

This is fragment 1 This is fragment 2

* % % W W i*?*i*?i*?\m

[+ CheckBox
O RadioButton

O RadioButton

A o —
The screeshot on the left is taken on Android 4.x while the right one is taken on

Android 2.x.

The complete project (sample codes) is available at FragmentExample.zip
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3 Handle long-running task

If you have certain time consuming tasks or there are some operations need to be
executed in background, you must implement the block of codes in a separated
thread respectively. Since the main thread of an app in Android will also act as a Ul
thread, it is very important to keep this thread to response users action immediately,
otherwise they will receive an ANR (Application not responding) dialog. In this
workshop, we will use AsyncTask to achieve multi-threading.

When to use AsyncTask and Service?

To make it simple, use Service if the task doesn’t require interacting with the main
thread (e.g. Ul elements), and the task needs to be executed in background (e.g.
Listen to an incoming message) even the app is not brought to the front.

On the other hand, use AsyncTask for those tasks which will block the main thread.
However, the limitation of AsyncTask is that it can be created and executed from the

main thread only.

3.1 Use AsyncTask to load an image from Internet
1. Start a new Android Application Project in Eclipse and refer to the screenshot
below for application details. Again we will also create a new BlankActivity with

default activity name, layout and navigation type.

{3 New Android Application =

MNew Android Application
Iy The prefix 'com.example.’ is meant as a placeholder and should not be used ! y

Application Name:® AsyncTaskExample

Project Mame:® AsyncTaskExample

Package Name:® com.example.asynctaskexample

Minimum Required SDK:®|APIS: Android 2.2 (Froyao) v|
Target SDK:Q[APIIS: Android 4.1 (Jelly Bean) vJ

Compile With:0| API17: Android 4.2 (Jelly Bean) ~|
Theme:®[§Holo Dark v]

Choose the base theme to use for the application

[=s}
ot

'f_?:l < back Mext = Einish Cancel

20
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2. Replace the contents in activity_main.xml with the following markups. We will
add an ImageView and a Button to the screen.

<LinearLayout xmlIns:android="http://schemas.android.com/apk/res/android"
android:layout_width="fill_parent"
android:layout_height="fill_parent"

android:orientation="vertical" >

<ImageView
android:id="@+id/mylmage"
android:layout_width="200dp"
android:layout_height="200dp"
android:scaleType="fitStart"/>

<Button
android:id="@+id/loadlmage"
android:layout_width="wrap_content"
android:layout_height="wrap_content"

android:text="Load image"/>

<EditText
android:layout_width="fill_parent"
android:layout_height="wrap_content"/>

</LinearLayout>

3. Replace the contents in src/MainActivity.java with the following code:

package com.example.asynctaskexample;
import java.io.InputStream;
import java.net.URL;

import java.net.URLConnection;

import android.app.Activity;
import android.graphics.Bitmap;
import android.graphics.BitmapFactory;

import android.os.AsyncTask;

21



2012-13 Workshop on Android app development SIG on Innovative Software, COMP, HKBU
Session 2

import android.os.Bundle;

import android.view.View;

import android.view.View.OnClickListener;
import android.widget.Button;

import android.widget.ImageView;

public class MainActivity extends Activity {

ImageView iv;
Button loadBtn;

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
iv = (ImageView)findViewByld(R.id.mylmage);
loadBtn = (Button)findViewByld(R.id.loadlmage);
loadBtn.setOnClickListener(loadBtnListener);

private OnClickListener loadBtnListener = new OnClickListener(){
@Override
public void onClick(View arg0) {

new DownloadlmageTask().execute();

private class DownloadimageTask extends AsyncTask<Integer, Void, Bitmap> {
@Override
protected Bitmap dolnBackground(Integer... params) {
try{
String imglink =
"http://www.comp.hkbu.edu.hk/~sigis/android/public/picturel.jpg";
URL url = new URL(imgLink);
URLConnection conn = url.openConnection();
conn.connect();

InputStream is = conn.getlnputStream();
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BitmapFactory.Options options = new
BitmapFactory.Options();
options.inSampleSize = 4;
Bitmap bm = BitmapFactory.decodeStream(is, null, options);
is.close();
return bm;
} catch (Exception e) {

return null;

@Override

protected void onPostExecute(Bitmap result) {
super.onPostExecute(result);
if(result!=null){

iv.setimageBitmap(result);

4. Since we will get the image through the Internet, we have to declare additional
permission in AndroidManifest.xml. Go to the AndroidManifest.xml and add
<uses-permission android:name="android.permission.INTERNET"/> above the
<application> tag.

5. Run the app and click on the Load image button. After a while, you will have the
image loaded in the ImageView. You can continue with your typing in the text
field while the image is still loading.
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s AsyncTaskExample

Load image

AsyncTask Example

o =

6. To see the difference between with and without using the AsyncTask, you can
copy the code from dolnBackground to and add it to the OnClickListener inside
MainActivity.java. Next, add Thread.sleep(10000) before loading the image to
onClick() and dolnBackground() respectively . You will find that you won’t be able
to type anything in the text field while the image is loading and the ANR dialog
will be popped out soon.

You may refer to the code below of loadBtnListener for not using AsyncTask:

private OnClickListener loadBtnListener = new OnClickListener(){
@Override
public void onClick(View arg0) {
//new DownloadlmageTask().execute();
try{
Thread.sleep(10000);
String imgLink =
"http://www.comp.hkbu.edu.hk/~sigis/android/public/picturel.jpg";
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URL url = new URL(imgLink);

URLConnection conn = url.openConnection();
conn.connect();
InputStream is = conn.getlnputStream();
BitmapFactory.Options options = new

BitmapFactory.Options();

options.inSampleSize = 4;
Bitmap bm = BitmapFactory.decodeStream(is, null, options);
is.close();
iv.setimageBitmap(bm);

} catch (Exception e) {

Note: Starting from Android 3.0, the system does not allow any network
operation on the main thread. In order to simulate the Activity Not Responding
situation, you also need to add the following code in the onCreate() otherwise
android.os.NetworkOnMainThreadException will be thrown.

StrictMode.ThreadPolicy policy =
new StrictMode.ThreadPolicy.Builder().permitAll().build();

StrictMode.setThreadPolicy(policy);

And then add @SuppressLint("NewApi") above @Override of the onCreate()
since we set the minSdkVersion to 8 in AndroidManifest.xml
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- .
@ 5554:Galaxy_Nexus_4.2 =] e

AsyncTaskExample isn't
responding.

Do you want to close it?

Wait OK
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4 Embed Google Maps (API v2) in your app

There are several prerequisites for embedding Google Maps into any apps using
Google Maps APl v2:

1. Download and configure Google Play services SDK

2. Get two Maps API keys for debug build and release build respectively

3. Modify settings in AndroidManiFest.xml|

4. Add the Maps (MapFragment) to the activity

4.1 Download and configure Google Play services SDK
1. In Eclipse, select Window > Android SDK Manager.
2. Select Google Play services and then click Install.

F =

Android SDK Manager | (S |

Packages Tools
SDK Path: C:\Program Files (x86)\adt-bundle-windows-x86\sdk
Packages
Mame API Rev.  Status -

» [ () Android 1.6 (APL4)
| | > [ Android1.5 (API3)

a [ [ Extras
[] &8 Android Support Library 11 Shinstalled W
[[] B8 Google AdMob Ads SDK & ¥ Not installed N
] B Google Analytics SDK 2 W Not installed [l
[] 8 Google Cloud Messaging for Android Library 3 & Not installed
mm GDDgIE E} l Pl : = 4 A o Tkl
= ) oogle Play services, revision
":m GDDQ:EFB;; GoogleInc.
[C] @ Google A

Google Play Services client library and sample code

[C] B8 Google A Location: C:\Program Files (x86)\adt-bundle-windows-x86\sdk\extras\google\google_play_services
[] 58 Google {Installed from dl-ssl.google.com

[[] 8l Google Web Driver 2 -« Not installed

[ (58 Intel x26 Emulator Accelerator (HAXM) & Not installed

m

ra

Show: [¥]Updates/New [/]Installed  [T] Obsolete Select New or Updates Install packages..
Sort by: @ APl level ~) Repository Deselect All Delete 1 package...
e

Done loading packages.

%

3. Accept the license and click Install again.
r Choose Packages to Install l = iz-1

Packages

Package Description 8¢ License

~ Google Play services, revision 3 Package Description -
Google Play services, revision 3

By Google Inc.

Google Play Services client library and sample code

Install path: extras\google\google_play_services

Archive Description
Archive for any 05

Size: 3.6 MiB
SHAL: 3580497 d2246bfb44497bebf0ddel 9a0bd0f0Gad

@Accept () Reject ©) Accept All

Install ] I Cancel
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4.

5.

In Eclipse, select File > Import > Android > Existing Android Code Into
Workspace. Click Browse and navigate to select
\adt-bundle-windows-x86\sdk\extras\google\google_play_services\libproject\
google-play-services_lib for the Root Directory.

(© B

Import Projects

Select a directory to search for existing Android projects

Root Directory:  C\Program Files (x86)%\adt-bundle-wind ows-x86"sdk’\extras\c | Browse..

Projects:

{[7] google-play-services_lib (C:\Program Files (x86)\adt-bundle-windows-x| | Select All

Deselect All

Refresh

i@

Fi L[] [

[T Copy projects into workspace

Working sets

[C] Add project to working sets

'@:‘ MNext = [ Finish ] [ Cancel

Select google-play-services_lib under Projects and click Finish to import the

library project.

4.2 Obtain Google Maps API key

1.

Locate the keytool.exe in bin folder of Java JDK or JRE. E.g. C:\Program
Files\Java\jre6\bin. Press Shift+Right Click in the bin folder and choose Open
command window here.

Locate the debug.keystore (Debug keystore) in
C:\Users\<user_name>\.android\. Type keytool -list -v -keystore
"C:\Users\<user_name>\.android\debug.keystore" -alias androiddebugkey

-storepass android -keypass android.

28



2012-13 Workshop on Android app development SIG on Innovative Software, COMP, HKBU
Session 2

BN Administrater: C\Windows\system32\cmd exe |££‘£_hj

C:=“Program Files Cx86)“Java‘jreb~hinX*keytool -list —v —keystore "C:\llserssfelixt
am*.android~debug_keystore'" —-aliaszs androiddebugkey —storepass android —keypass a
ndroid
Alias name: androiddebugkey
Creation date: Dec 5. 2812
Entry type: PrivateKeyEntry
Certificate chain length: 1
Certificatell1:
Ouner: CN=Android Debug. O=fAndroid. C=US
Izzuer: CH=Android Debug, O=Android,. C=U§
Serial number: S5ALF2252
Ualid from: Wed Dec A5 18:38:42 CST 2812 until: Fri Hov 28 18:3@A:42 CST 2842
Certificate fingerprints:
MD5: Z26:6F:B4:EA:60:96:29:6A:3E:21:FE:AG:E4:51:3D:95
SHAL1: O1:2E:8D:AF:C1:62:6B:C1:A4:68:A5:39:3B:58:9B:E6:41:81:C4:76
Signature algorithm name: SHAlwithRSA
Version: 3

C:“Program Files (xB6)~Java‘jreb bin2_

e A

Note: If you are using windows XP, replace C:\Users\<user_name> with

C:\Documents and Settings\<user_name> of the path.

3. Copy the 20 two-digit hexadecimal numbers SHA-1 fingerprint. This fingerprint
will be used to obtain the corresponding Google Maps API key. (You can copy the
numbers by Right click > Highlight the number > Right click)

4. Start your browser and go to https://code.google.com/apis/console/. Login with

your Google account and click the Create project button.

(=] B -
- B Google APIs Conscle x
€« C f G nttps//code.google.com/apis/console g =

Search Images Maps Play YouTube Mews Gmail Drive More whkbucompdev@gmail.com v | Settings v | Help | Sign out

Go 3[(‘ apis

Start using the Google APIs console
to manage your APl usage

‘
Creating an APIls project will let you

+ Use Google APIs beyond anonymous limits
+ Monitor API usage and control AP| access
+ Share APl management with a team

Create project...
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5. Scroll down and find out Google Maps Android API v2. Activate it and accept the

license agreement.

@ - Dﬁlg

S B Google APIs Console x \'
B o i ; S —— - : ™
L = C A G nttps//code.google.com/apis/console/#project:625479181086:services icd
dCCESS. . refuests/aay R
2 Google Compute Engine @ Request Pricing
ACCess...

% Google Maps AP 2 @ Courtesy limit: 26,000
requestsiday » Pricing
%5 Google Maps APIv3 @ OFF Courtesy limit: 25,000
requests/day * Pricing
E" Google Maps Android API v2 @ [[Tor)
= Google Maps Coordinate AR ? [CTore]) Courtesy limit: 1,000 =
requests/day
b7 Google Maps Geolocation AP @ [[Torr) Courtesy limit: 0
requests/day » Pricing
Google Play Android Developer API @ Courtesy limit: 15,000
requests/day
% | Google+ API @ OFF Courtesy limit: 10,000
requests/day
Bl ~onnlns Unonose ADI (7] OFF saadbeadhacky) -
4 T | »
developers.google.com/maps/.../index
6. Make sure the status of the APl is On.
H K Google Maps Android APIv2 @ EN) ‘ ‘

7. Click on APl Access in the left panel and select Create new Android key.
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e Autherized APl Access
APl Access
Reports OAuth 2.0 allows users to share specific data with you (for example,
contact lists) while keeping their usernames, passwords, and other
o= information private. A single project may contain up to 20 client IDs.
I Learn more

Create an OAuth 2.0 client ID...
Simple APl Access

Use API keys to identify your project when you do not need to access user data. Learn more

Key for browser apps (with referers) Generate new key...
AP key: ATzaSyAEYL2VLYQTxvpGqUgshNmQ1MUos Ft allonicn o
Sellac
Delete key...
Refarers: Any referer allowed
Activated on: Dec 9, 2012 7:34 PM
Activated by: hkbucompdev@gmail.com — you

Create new Server key. . | Create new Browser key._ | Create new Android key. .

Code Home - Privacy Policy

' Send Feedback |

-

8. Paste the SHA-1 fingerprint and add the package name of the app separated by a
semi-colon. In our example, the package name will be
com.example.googlemapsv2 which will be used in the next section.

Configure Android Key for APl Project

This key can be deployed in your Android applications.

APl requests are sent directly to Google from your clients’ Android devices. Google verifies that each
request originates from an Android application that matches one of the certificate SHA1 fingerprints
and package names listed below. You can discover the SHAT fingerprint of your developer certificate
using the following command:

keytool -list -v -keystore mystore.kevstore Leam more

Accept requests from an Android application with one of the certificate fingerprints
and package names listed below:

01:2E:8D:AF:C1:62:68:C1:R4:65:R5:39:38:50:98:E6:41:81:C4:76;com.example.

googlemﬂgsvg

One SHAT certificate fingerprint and package name (separated by a semicolon) per line. Example:
45:B5:E4:6F:36:AD:0A:98:94:B4:02:66:2B:12:17:F2:56:26:A0:E0:com. example

;. Create | Cancel

9. Click the create button and you will get the API key of the debug certificate under
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Key for Android apps (with certificates).
r —— =

= | B Google APIs Console %\

&= C # | & https;//code.google.com/apis/console/#project:625479181086:access o= ‘
APl Access -
Reports OAuth 2.0 allows users to share specific data with you (for example

| ; contact lists) while keeping their usernames, passwords, and other
== information private. A single project may contain up to 20 client IDs
Learn more
Create an OAuth 2.0 client ID...
Simple APl Access | _
Use API keys to identify your project when you do not need to access user data. Learn more
Key for Android apps (with certificates) Generate new key
AP key: S e
i TexRyOX=T apps
Android apps: 01:2E:8D:AF:Cl:62:6B:Cl:RA4:68: |
Delete key
A5:39:3B:50:9B:E6:41:81:C4:76;
com.example .googlemapsva2
Activated on: Dec 9, 2012 7:42 PM
Activated by: hkbucompdev@gmail.com — you
Key for browser apps (with referers) Generate new key =
[ APl key: LTIzaSyRAEYL2VLYQTxypGqUgShNml MU El lnersl v
os5ellac
Delete key
Referers: Any referer allowed
Activated on: Dec 9, 2012 7:34 PM
Activated by: hkbucompdev@gmail.com — you
Create new Server key... | Create new Browser key_.. | Create new Android key...
Code Home - Privacy Policy
Send Feedback | -

10. For the API key of the release certificate, simply repeat the steps but replace the
location of the debug certificate with the release certificate in step 2.

4.3 Embed Google Maps in your app

1. Start a new Android Application Project in Eclipse and refer to the screenshot
below for application detail. Again we will also create a new BlankActivity with

default activity name, layout and navigation type.
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i3 New Android Application

T = i |

New Android Application

15 The application name for most apps begins with an uppercase |etter

Application Mame:® googlemapsv2
Project Mame:® googlemapsv2

Package Mame:® com.example.googlemapsv

Minimum Required SDK:®|APIE: Android 2.2 (Froya)

Target SDK:@IAF‘I 16: Android 4.1 (Jelly Bean)

CDmpiIeWith:®|AP11?: Android 4.2 (Jelly Bean)

Theme:@IEHolo Dark

. Choose the base theme to use for the application

—
~
[=s}
o
g
W

Finish Cancel

2. Open AndroidManifest.xml and add the following markups:

® Add <meta-data

android:name="com.google.android.maps.v2.API_KEY"

android:value="your_api_key"/> as a child of <application> element.

Replace the API key with the one you generated in step 9 of section 4.2.

® Add <permission

android:name="com.example.googlemapsv2.permission.MAPS_RECEIVE"

android:protectionLevel="signature" />

<uses-permission

android:name="com.example.googlemapsv2.permission.MAPS_RECEIVE"

/> above the <application> tag. Remember to replace the com.example.

googlemapsv2 with your own package name of your app.

® Add <uses-permission android:name="android.permission.INTERNET" />

<uses-permission

android:name="android.permission.WRITE_EXTERNAL_STORAGE"/>

<uses-permission android:name=

"com.google.android.providers.gsf.permission.READ_GSERVICES" />

above the <application> tag. This will ask the permission from users to
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download the map tiles through the Internet, allow the API to access
Google web-based services and cache the map tiles in the external storage
respectively.
® Add
<uses-feature
android:glEsVersion="0x00020000"
android:required="true"/> above the <application> tag. This is
used to declare the hardware or software feature which is required of a
device.
3. In Package Explorer, right click the project (googlemapsv2) and select Properties
> Android > Add. Select google-play-services_lib and press OK. This will include
the Google Play Service library when compiling the app.

{¥ Properties for googlemapsv2 [ = ihJ
type filter text Android = =
> Resource
Android Project Build Target
id Lint Pref
An.drol (Nt FrErerences Target Name Vendor Platform APIL..
Builders -
Java Build Path [ Android2.33 Android Open Source Project 233 10
. Java Code Style [[] Google APIs GoogleInc, 233 10
. Java Compiler [7] Intel Atom x86 Syste...  Intel Corporation 233 10
» Java Editor [¥] Android4.2 Android Open Source Project 42 17
lavadoc Location
Project References
Run/Debug Settings
Task Tags )
.+ Validation Library
[C]1s Library
Reference Project Add...
+ UL \sdk\extras\googlelgoogle_pl...  google-play-services_lib
Remove
1 lRestoreQefaults] l Apply
':;:' [ oK l I Cancel

4. Replace the content of activity_main.xml with the following markups:

<RelativelLayout xmlins:android="http://schemas.android.com/apk/res/android"
xmlns:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"
tools:context=".MainActivity" >
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<fragment xmlins:android="http://schemas.android.com/apk/res/android"
android:id="@+id/map"
android:layout_width="match_parent"
android:layout_height="match_parent"
class="com.google.android.gms.maps.SupportMapFragment"/>

</RelativeLayout>

5. In package explorer, right click libs/android-support-v4.jar and choose Build Path
> Add to the Build Path.

6. Replace the contents in MainActivity.java with the following code:

package com.example.googlemapsv2;
import android.os.Bundle;

import android.support.v4.app.FragmentActivity;

public class MainActivity extends FragmentActivity {

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

7. Please note that you have to test the app in the real device instead of emulator.
Emulator does not include Google Play Service (Even you pushed Google Play
services APK to the emulator). Remember to activate your internet connection.
You will soon see the map and able to use two fingers to change the bearing and

angle of the view.
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The complete project (sample codes) is available at googlemapsv2.zip
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5 Reference and learning resources

e  Official Android developer website:
http://developer.android.com/index.html

e  Many common questions raised by other developers previously:
http://stackoverflow.com/

e  Many Android tutorials with complete source code:
http://www.anddev.org/

®  More details on implementing Action Bar
http://developer.android.com/guide/topics/ui/actionbar.html

e  Special Interest Group on Innovative Software homepage:
http://www.comp.hkbu.edu.hk/~sigis/
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